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OLLI at SOU Teaching on Zoom Reference Guide  

This reference guide is an overview for Teaching on Zoom for OLLI at SOU. It includes general 
information, best practices for preparing for your course and being Zoom-ready, communicating with 
your students, and facilitating a class session for both online and hybrid instructors.   

Before you begin reading, please start a Zoom meeting so you can see the Zoom features included in this 
Guide. Now, before we begin, thank you for teaching online. We hope it is a rewarding experience for 
you and your students. 

Items in bold text are things that you click on-screen.  

Preparing for Teaching on Zoom  

1. Instructors receive an email from the OLLI office with information about obtaining a Zoom 
account about six weeks before the term begins. The choices are purchasing your own Zoom 
Pro account or requesting a SOU Zoom account for the term. Zoom Pro and SOU Zoom are 
similar though some Zoom Pro features may not be available in SOU Zoom.  

2. Instructors will receive an email from the OLLI office on how to access the course roster.  It’s 
best to access your roster each time you email your students as a roster can change daily as 
students add or drop a course. 

3. We ask all instructors to email a “recurring” Zoom Join link to their students one week before 
their first session and again the day before each session. You will receive an email from the OLLI 
office regarding this process.  See Attachment B for how-to create a recurring link. Please take 
a few minutes to create a meeting invite and email to a friend before the training session.    

4. Feeling comfortable with teaching on Zoom requires practice. Many online instructors have 
found it useful to Record their practice sessions and adjust their lesson plan.  

5. Have a test meeting to verify that your internet connection, video and audio are all working. 

6. Avoid bandwidth problems (e.g., video screen freezing and intermittent audio) by making sure 
others in your home aren’t streaming media or using excessive bandwidth while you are 
teaching. Bandwidth can improve if you connect your device to the router with an ethernet 
cable, or move closer to your router. Remember, blurred and virtual backgrounds require more 
bandwidth. Click here for some useful information on connection issues on the Zoom website.  

7. It is best to keep your lesson plan simple until you feel confident teaching on Zoom. Include in 
your lesson plan every Zoom feature you plan to use by the Control name and when it will be 
used. Also include when you will take a mid-way 3–5-minute break.  

https://zoom.us/test
https://support.zoom.us/hc/en-us/articles/201362463-Wireless-WiFi-connection-issues
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8. We recommend instructors pause their presentation for Q&A and discussion. This helps keep 
students engaged.   

9. Instructors recommend asking one of your students to be a Zoom co-host.  This might be 
someone already familiar with Zoom or someone willing to learn a few Zoom controls. Co-host 
training is available. Click here for co-host info on the Zoom website.  

10. If you have a co-host, it’s important to set aside some time to practice together. Discuss with 
your co-host how the co-host can assist. This might include re-muting students, noting the 
names of students who have raised their hand, and monitoring the Chat window.  

11. Don’t be surprised by the “silence” of teaching online, or that some students will choose not to 
turn their video camera on. Finally, anticipate that despite your best efforts, technical problems 
happen and not all students will be experienced with the Zoom tools.  

Be Zoom Ready  

1. Set-up your teaching space with bright lighting in front of you if possible. Lamps are great if set 
directly behind your computer. Try to avoid shadows and test the lighting for the time of day 
when you are teaching.  Be sure the area is free of unnecessary distractions and intrusive sounds 
such as spinning ceiling fans and pets.   

2. Remember you are on camera. It is best if your face is centered in the Zoom window both 
vertically and horizontally. If the camera is lower or higher than eye level, try to adjust the height 
of your PC, camera, or chair. When using notes, try to keep them at eye level and close to the 
camera so you are not repeatedly looking down or away.  

3. We recommend that if you are not seeing on Zoom what you expect to see, or a Zoom Control 
is not working as you expected, the setting may need to be changed from the preset defaults.  

4. Check periodically if you have the latest Zoom version. To check for the latest release, click your 
Username initials or photo on the Zoom website home page, then click Check for Updates. Zoom 
will update to the latest version.  

Let’s Take a Look at What Appears in the Zoom Window:   

1. To Start a meeting, in the Zoom app, Sign-in to either your SOU Zoom or Zoom Pro account, 
then click Home on the top left and then New Meeting.  

2. Along the top border of the Zoom window on the far-right side is View. Click View to select 
how to view the participant videos, known as thumbnails. The two primary options are Gallery 
(all participant videos) or Speaker view. Speaker view will display the thumbnail of the 

https://support.zoom.us/hc/en-us/articles/201362603
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participant speaking. View also enables Fullscreen or Exit Fullscreen. Click here for info on 
View on the Zoom website.  

3. In the left lower corner of each thumbnail video is the participant’s Zoom name. In the right-
upper corner of the thumbnail video are Zoom controls available to the host (instructor) or 
co-host. The participant (student) will see a different set of controls when they click their own 
thumbnail. More on these controls in the Zoom Tools section.  

4. Depending on how many students are in your class, and your own computer’s capabilities, you 
may not see all of your student thumbnails on one screen. To view all of your student 
thumbnails, click the arrow icon on the far side of the Zoom window to view more student 
thumbnails.  

5. To the left of View is the green Zoom shield with “Meeting Information.” This window has 
your Meeting ID, Passcode, and the meeting’s IP address.  We recommend you click this icon 
as soon as you start each class session to confirm that the Invite link is for the same Zoom 
meeting as the link you sent to your students.   

6. Along the bottom of the Zoom window is the Zoom Control toolbar with the various Zoom 
controls: Audio, Video, Participants, Chat, React, Raise Hand, Share, Host tools, AI 
Companion, Apps, More. These most important of these controls are explained in the Zoom 
Tools section below.  

7. The Zoom Control toolbar will auto-hide when not used, but it will reappear if you hover the 
mouse along the bottom of the Zoom window.  The Control toolbar will move to the top of 
your Zoom window when you Share your content.  

Zoom Tools on the Zoom Control Bar 

1. Audio and Video both turn on and off by clicking the mic and camera icon on the bottom left of 
the Zoom window. Click the ^ for more audio and video settings and options. If you have audio 
problems with your microphone, an external microphone may be advised. Click here for info on 
the Zoom website about testing audio and video info.   

2. Participants shows the number attendees to the right side. Click Participants to open the 
Participants window which will appear on the right side of the Zoom window.  

a. Your name will appear at the top of the list and below your name is a list of all 
participants. Alongside of each participant’s name are two buttons, Mute and More 
(or three dots).  More has a list of other settings. The host’s and co-host’s list will 
include different settings than a participant’s settings.  

https://support.zoom.us/hc/en-us/articles/201362323-Changing-the-video-layout-Active-Speaker-View-and-Gallery-View-
https://support.zoom.us/hc/en-us/articles/201362323-Changing-the-video-layout-Active-Speaker-View-and-Gallery-View-
https://support.zoom.us/hc/en-us/articles/201362283-Testing-computer-or-device-audio
https://support.zoom.us/hc/en-us/articles/201362283-Testing-computer-or-device-audio
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b. On the bottom of the Participants window is Invite which allows you to email the 
session’s Zoom link from your live meeting, and tool Mute All. Mute All is very helpful 
to manage unwanted noise during class. It is best to Mute All at the beginning of class.   

3. During the class session, the instructor or co-host can quickly Mute any participant who has 
become unmuted. Unmuted students can be identified as their names will appear in the 
participant’s window just below the instructor and co-host names. Mute these students by 
clicking Mute next to each name.   

4. Chat is a useful feature for students to post comments, questions, links to relevant 
information for all participants to see. You or your co-host can monitor what is being posted 
in Chat. You can also use these posts to add to your content. There are different options to 
restrict or disable Chat but likely your students will expect this feature is enabled.  Click here 
for info on the Zoom website about Chat 

5. Raise Hand  is very useful for Q&A and during a discussion. A raised hand will place the 
student’s thumbnail video at the top of the gallery in a sequential order. We recommend that 
you, or your co-host, note the names of students who wish to speak as Zoom might after some 
time lower a raised hand. Zoom will raise the virtual hand when a student raises their physical 
hand but this is not as certain as a student clicking Raise Hand. 

a. You, your co-host, or the student, can also lower their virtual raised hand by clicking 
Lower Hand from their thumbnail or the Participants List.  

6. React includes other icons which enables students to share a non-verbal reaction, express 
emotions, or provide quick feedback without interrupting the flow of conversation.   

7. Share is used for showing a PowerPoint presentation or media like YouTube, video, or a music 
clip.  When you are sharing content, it is a best practice to break your presentation into 
chunks and periodically reengage with your students. You can use Pause, or to close the 
content, click Stop share.   

a. When you are sharing content, the Control icons will now move to a floating toolbar at 
the top of your screen along with the Share toolbar, and other open windows like CHAT 
will be significantly minimized. This toolbar can be moved by dragging it. Only a few of 
the thumbnail videos will appear.  

b. It is important that once you prepare your material, you invite a friend to a Zoom meeting 
and Share your material from start to finish. Refer to Attachment C for how to share 
content in Zoom.  

https://support.zoom.us/hc/en-us/articles/203650445-In-meeting-chat
https://support.zoom.us/hc/en-us/articles/203650445-In-meeting-chat
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8. Host tools includes a long list of settings which enable/disable features for Participants, and a 
few Host controls. Note: If you have a waitlist, it is best to check Waiting Room.  This feature will 
enable a pop-up window to appear on the top of the Zoom window whenever a participant enters 
the Waiting Room. The instructor or co-host can confirm the name is on the roster before clicking 
Admit.   

9. More has many Zoom controls which may be useful for including in your lesson plan. Here are a 
few that are more frequently used.   

a. Captions is for transcribing speech to text. The text will appear on the bottom of the Zoom 
window. Click here for info on the Zoom website for Managing manual captions. 

b. Record the session is another option to consider. On Zoom Pro, you can record on your 
computer or to the Cloud. On SOU Zoom, you can only record on your computer. To 
record, click Record and then the appropriate Recording option. Click Pause Recording 
during a break, Resume again when class restarts, and Stop Recording when you are 
finished. This could be done by a co-host. Once the recording ends, the computer will 
process the recording and save the recording on your computer or Cloud as you selected. 
A recording on your computer can then be zipped and emailed to your students. You can 
send a link to view the recording in the Cloud. Note: If you plan to record your class, SOU 
Policy requires that students be told in advance. If a student objects, ask the student to 
click Stop Video and Rename Themselves.  Click here for info on the Zoom website about 
Recording a Meeting.          

c. Breakout Rooms create smaller discussion groups or collaborative teams so your students 
can communicate and learn from one another. This replicates the common practice of 
breaking the class into small groups. Zoom will automatically assign your students to as 
many rooms as you specify or you can assign students to particular rooms. Click here for 
info on Breakout Rooms on the Zoom website. 

Summary A: Step-by-Step Plan for Facilitating an Online Course  

Send the Link 

1. Email yourself and (BCC) all students on your latest roster the same Zoom link one week before 
your course begins and again each week on the day before your next session.   

Set-Up Your Zoom Meeting Room  

1. Before each session, be sure your teaching space is well-lit, quiet, and free of distractions. Open 
your presentation materials and close all other documents/apps you’re not using. 

 

https://support.zoom.com/hc/en/article?id=zm_kb&sysparm_article=KB0062490
https://support.zoom.us/hc/en-us/articles/201362473-Local-recording
https://support.zoom.us/hc/en-us/articles/201362473-Local-recording
https://support.zoom.us/hc/en-us/articles/206476313-Managing-breakout-rooms
https://support.zoom.us/hc/en-us/articles/206476313-Managing-breakout-rooms
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2. Open your session fifteen minutes before the session is scheduled to begin.  

3. To open the Zoom meeting, be sure you are signed-in to the correct Zoom account (Zoom Pro 
or SOU Zoom) and are signed-out of any other Zoom account you might use. Click on the Zoom 
link you created for this course and once the meeting is opened, click the Zoom Shield icon on 
the Zoom window’s top border to be sure the Invite Link, Meeting ID, Passcode are what you 
emailed your students.   

4. At the top of your Zoom window, click View and check Gallery so you can see your students’ 
thumbnail videos. For classes with more students than can appear on your Zoom window, click 
the arrow key on the far side of the Zoom window to view more student thumbnails. 
Depending on your computer, the maximum number of thumbnails per page is 49.  

5. On the Zoom Control toolbar on the bottom of your Zoom window, turn YOUR microphone on 
by clicking the Mute icon. Clicking the ^ will display settings for your microphone. Test your 
audio volume.  

6. Now turn YOUR camera on by clicking the Video icon on the Control toolbar. Clicking the ^ will 
display camera settings and options. 

7. Click Host tools on the Zoom Control toolbar and check or uncheck the features you wish to 
enable/disable.   

  Begin class and welcome the students   

1. Welcome students as they arrive. Encourage your students to use View > Gallery so they can 
see the other students, especially in a discussion course.  

2. If a student’s thumbnail video name is not their first and last name, ask the student to Rename 
themselves by clicking on their thumbnail name, or Rename, and entering their full name in 
the pop-up window. Renaming can also be done by the instructor or co-host.  

3. If you have a co-host, click open the Participants window and click More to the left of the co-
host’s name and Assign Co-host.   

4. Inform students how and when you will pause for Q&A and discussion.  Ask students wishing 
to speak to click Raise hand on the Zoom Control bar.  A raised hand will place the student’s 
thumbnail video at the top of the gallery in a sequential order. Note: Zoom can raise the virtual 
hand when a student raises their physical hand but this is not as certain as a student clicking 
Raise hand. You, your co-host, or the student, can lower the virtual raised hand by clicking 
Lower hand. 

5. Each session it is wise to remind students to remute after speaking.  Be prepared that some 
students may have difficulty quickly unmuting and will forget to remute or lower their hand. 
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If needed, you, or the co-Host can remute students by clicking Mute alongside the student’s 
name in the Participants window.    

6. Once you are ready to begin your presentation, click Mute All on the bottom of the 
Participants window to eliminate unwanted noise from a student’s microphone.  

7. If you are sharing a presentation, click Share on the Zoom Control toolbar when you are ready 
to share your material with your students and Stop Share when you have finished.  

8. Take a short 3–8-minute break mid-way through your session.  Take periodic breaks for Q&A 
during a presentation.  

9. When your class is over, click Stop Recording. Wrap-up and ask if there any questions or 
comments.  

10. Click End and then End Meeting for All (bottom right of screen) when done.  

Summary B: Step-by-Step Plan for Facilitating Your Hybrid Class  

Send the Link 

1. Email yourself and (BCC) all students on your latest roster the same Zoom link one week before 
your course begins and again each week on the day before your next session.    

Set-up in the classroom  

1. The hybrid set-up takes time so be in the classroom 30 minutes before your class session.  If you 
are using the OLLI PC or MacBook allow for extra time to go to the OLLI office to check out the 
laptop.    

2. Be sure to plug in your laptop so your battery does not become depleted before your class session 
ends. Zoom uses more power than you might expect.  

3. From your training session notes, follow the hybrid set-up plan for the camera, mic, and laptop 
you are using. Remember, while many of the laptop settings are defaulted, other instructors may 
have used the OLLI laptop after the initial setup, so it is worth re-checking settings.   

4. If you are using the Osbot camera and teaching at the podium, set the hand signal 
so the camera follows you.  If you are teaching with a co-instructor, make sure to 
use a hand signal to release the Osbot so the other instructor can set the hand signal to follow 
them. 

5. Open the Zoom session and sign-in with the same password and meeting ID that you sent to your 
students. Click on the Zoom Shield icon on the Zoom window’s top border to be sure the Invite 
Link, Meeting ID, Passcode are what you emailed your students.   
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6. At the top of your Zoom window, click View and check Gallery so you can see your students’ 
thumbnail videos. Note: For classes with more students than can appear on your Zoom window, 
you can click the arrow key on the far side of the Zoom window to view all your student 
thumbnails.  

7. On the Zoom Control toolbar on the bottom of your Zoom window, turn YOUR microphone on 
by clicking the Mute icon. Clicking the ̂  will display settings for your microphone. Test your audio 
volume.  

8. If using the Obsbot camera and Yeti microphone stand, click on the ^ next to Video and verify 
Obsbot camera is selected. Do the same under Audio to verify Yeti microphone is selected. 

9. Click Host tools on the bottom Zoom toolbar and check or uncheck the features you wish to 
enable/disable.   

10. Once the co-host joins the session, assign the co-host.     

11. Remove the lapel mic from the podium drawer. Attach the lapel mic clip to garment’s neckline 
and turn on by flicking the switch. The green light will appear.  To be sure the lapel mic is working,  
move away from the mic stand and should hear their voice over the classroom speakers. 

12. Unmute the laptop speakers and unmute the microphone in the Zoom toolbar. Conduct a sound 
check with the Zoom co-host while standing at the podium. Adjust the sound level on the laptop 
speaker controls if the volume is too low or too high.   

13. Once the sound level is set, mute the Zoom mic and the speakers. This ensures that before class 
and during breaks that the conversations from the Zoomies are not heard in the classroom, and 
the Roomies conversations are not broadcast to Zoomies.    

  Begin class and welcome your students   

1. Unmute both the Zoom mic and the laptop speakers.   

2. Welcome the students and introduce yourself and your co-host(s) and explain how this is a hybrid 
class and you will alternate back and forth from the Zoomies to the Roomies for Q&A and 
discussion. We recommend you also provide this direction at the beginning of the class:  

a. Roomies, please silence yourselves unless you are speaking to the class.  When you wish to 
share in the discussion or ask a question, please raise your hand. I will repeat your question, 
or what you shared.   

b. Zoomies, please set your view to Gallery and keep your microphone muted. When you wish to 
speak, click Raise Hand so you can be seen in the speaking queue. When you are finished 
speaking, please Mute yourself.   

3. If the co-host is recording for the instructor on their computer, co-host can Start recording now.   
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4. Proceed instructing until it is time for a break.   If you are sharing a presentation, click Share on 
the Control toolbar when you are ready to share your material with your students and Stop Share 
when you have finished.  

  Class Break    

1. Announce the break and then mute the Zoom mic and Mute the laptop speakers. This keeps 
Roomie conversations from broadcasting to the Zoomies, and the Zoomie conversations from 
being broadcast to the Roomies.   

2. Co-host should Pause the recording.   

3. When the break has ended, ask students to return to their seats.   

4. Before session resumes, Unmute Zoom mic and the laptop speakers and ask the co-host to 
resume Record.    

At End of Class   

1. Mute Zoom mic and laptop speakers.   

2. Host or Co-Host should Stop recording.   

3. End the Zoom session, then End meeting for all.   

4. Turn off classroom electronics using touchscreen on podium. Push “Shut Down” in upper right 
corner of screen, then confirm with “Yes.”    

5. Leave Chromebook on the top of the podium.  

6. Return all equipment to the drawer. Return any borrowed laptop to the OLLI office. 

7. Set moveable microphone stand to the side of the room.    

Additional Instructions and Videos from Zoom Tech Support  

Click here for information on the Zoom website about sharing presentations.  

Click here for info on the Zoom website about sharing a PowerPoint presentation.  

Click here for help on the Zoom website about sharing a video clip.  

Click here for help on the Zoom website on how to share the Whiteboard  

https://support.zoom.us/hc/en-us/articles/201362153-Sharing-your-screen-in-a-meeting
https://support.zoom.us/hc/en-us/articles/203395347-Screen-sharing-a-PowerPoint-presentation
https://support.zoom.us/hc/en-us/articles/202954249-Optimizing-a-Shared-Video-Clip-in-Full-Screen
https://support.zoom.us/hc/en-us/articles/205677665-Sharing-a-whiteboard


 

OLLI at SOU Teaching on Zoom Reference Guide - 10 - Updated March 2025 
 

Attachment A: Schedule a Meeting 

Open the Zoom desktop app on your computer.  
On the Home page, click Schedule.  
The Schedule Meeting Window shown below 

will open.  

1. Enter your course title in the Topic.  

2. Enter or leave Date and Time blank.  

3. Check Recurring meeting.  

4. Leave all other fields as noted.  

Click Save.  

  

• Once saved, the Zoom link is created and can be copy/pasted into your email. The link can be 
used at any time to Start a meeting. The link does not expire. Edit the email to include specific 
information about your class. Delete all the unnecessary Zoom telephone numbers and other 
information.  

• Email the link (BCC) to your students one week before your first session and one day before 
each session during the duration of your course. Be sure to use your latest roster each time you 
email.   

• By checking Recurring meeting, this class meeting will always appear in your list of Zoom 
Meetings, so it’s easy to find. 
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Attachment B: How a Zoom Co-host Can Assist an Instructor:  

How a Zoom Co-host Can Assist an Instructor:  

1. If a student’s thumbnail video name is not their first and last name, the co-host can ask the 
student to Rename themselves with their first and last name, or the co-host can enter the first 
and last name for the student. Note: Click More > Rename from the Participant List or the video 
thumbnail and enter the name in the pop-up window.  

2. Individually Mute any student who becomes unmuted during class.  Note: The names of unmuted 
students will appear below the instructor’s and co-host’s names in the Participants window. 

3. After a student has finished speaking, click Lower Hand on the student’s thumbnail.  

4. Let the instructor know if any shared screen media is not what is expected.     

5. Monitor Chat and let instructor know if there are questions or comments to share.  

6. If the instructor intends to Record on their computer, manage Start and Stop Recording, or 
remind the instructor to Start and Stop Recording on their computer.  

7. Hybrid co-hosts: Remind instructors to repeat all Roomie questions. 

8. Hybrid co-hosts: If recording for the instructor, begin and end Record and email to the instructor 
following the session. 

 

  



 

OLLI at SOU Teaching on Zoom Reference Guide - 12 - Updated March 2025 
 

Attachment C: Sharing on Zoom 

Zoom has several ways to share your content in a class. The most commonly used are Share Screen, 
Share a Presentation, and Share audio or video. 

1. Share Screen / Share Presentation / Share audio or video 

a. Open the application(s) you want to share. For videos like YouTube, go to the video 
in your browser, advance and pause after any ads. For a presentation, have it ready 
to present but don't click Play yet. 

b. Caveat: some online videos are protected so that they can't be played in a Zoom 
meeting, or you have to play it from YouTube anyway. Try this out before your class 
to be sure that it will work. 

c. Click the green Share button on the Zoom toolbar. 

d. In the popup window that appears, select what you want to Share - Desktop shares 
everything on your computer screen. Select just one application (like PowerPoint or 
Keynote) if you want to share only that application. (If you have multiple monitors, 
you can select the one you want to use - Desktop 1, Desktop 2, etc). 

e. If you are sharing audio or video, click the Share sound checkbox on the right for 
(mono or stereo).  This gives the audio from your content better quality. 

f. If you are sharing video, click the Optimize for video clip checkbox. 

g. You must click the blue Share button to start the Sharing before students can see 
your content! 

h. A green border appears around whatever you are sharing as a reminder.  

i. The Zoom toolbar will move to the top of your screen to get out of your way. You can 
drag it around if it's still in your way, or click the curved arrow to dock it to the top or 
bottom of the screen.  It auto-hides when you're not using it - hover over it to re-
appear. (The red Stop share button does not auto-hide.) 

j. Now go to the application you want to share.  

i. For example, if it's PowerPoint or Keynote, click Play in the presentation and 
present your slides. Remember to stop occasionally for questions. 

ii. If it's an audio or video clip, click Play in your audio or video player, or YouTube 
window. If you forgot to click Share sound, or Optimize for video clip, they 
are available in the toolbar under More. 
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k. To change to another application, you don't need to Stop share, just click the Share 
button again and you'll get the same window you had before to select something 
else. Remember the blue Share button! 

l. When you are finished sharing, click Stop Share to return to the Zoom window. 

 

2. Embed audio or video in a Presentation 

a. This method embeds your audio or video in a Presentation slide, so you don't have 
to switch applications. It requires more preparation but it results in a more seamless 
presentation. 

b. Caveat: some online videos are protected so that they can't be played in a Zoom 
meeting, or you have to play it from YouTube anyway. Try this out before your class 
to be sure it will work.  

c. This example uses YouTube video but other video services (and audio) are similar. 

d. Find and open your video in a browser. 

e. Advance past any ads and Pause. Click the curved Share arrow . In the popup 
window, click Start at  to have the link start past any ads, then click COPY to get the 
resulting link. 

f.  Now open your Presentation at the slide where you want to embed the video.  

i. In PowerPoint, click Insert > Video > Online Movie... and paste the link, then 
click Insert. 

ii. In Keynote, click Insert > Web Video... and paste the link, then click Insert. 

iii. You can resize the frame that the video will be placed into. 

iv. Remember the Share sound, or Optimize for video clip checkboxes before 
you Share. 

g. You may see a Security warning about "References to external media".  If so, click 
Enable Content.  

h. Now play your presentation, and on the slide with embedded video, click the Play 
button. 

i. When you are finished sharing, click Stop Share to return to the Zoom window. 

Click here for more information about Sharing on Zoom. 

https://support.zoom.com/hc/en/category?id=kb_category&kb_category=8a49729a8720391089a37408dabb35ea
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